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Using FamilySearcher To Search the Internet IGI 
Starting with Personal Ancestral File 5.2.18 

By Kevin Owen 
kevinowen3@cableone.net 

© Copyright 2004 
 
Objective: This document describes how to install the FamilySearcher program on your computer. 
Details are given describing how to use PAF 5.2 to generate a GEDCOM file for use with the 
FamilySearcher program containing the names of those individuals who have incomplete LDS 
Temple Ordinances.  The steps required for basic use of the FamilySearcher program on an 
Internet-connected windows PC are also given.   
 
Description: FamilySearcher is a windows software application that reads a GEDCOM file and 
presents a list of names and dates found in the file.  It also launches Internet Explorer in a separate 
window and allows a simple “point and click” on a selected name in the FamilySearcher window to 
initiate a search of the FamilySearch Internet site for possible matching LDS Ordinance 
information.  FamilySearcher can also be used to search the other resources at FamilySearch.org as 
well as several other key genealogical web sites such as Ancestry.com, Rootsweb.com, 
EllisIslang.org and others that will be added as time goes on.  This document only discusses the 
steps required to search the Internet IGI at FamilySearch.org. 
 
Equipment: A Windows PC equipped with PAF 5.2, Internet Explorer and an Internet connection. 
 
Preliminary Steps: Take a backup of your PAF data to your local Family History Center and use 
the “Update My Records” capability of the Temple Ready program.  After finding all completed 
ordinance information - back this data up at the Family History Center and restore it onto your 
home computer.  This will insert the ordinance dates for any completed Temple work into your PAF 
records – including Temple work completed through January of 2000. 
 
If you have not already done so – register at the FamilySearch web site so that it will be possible to 
see the Temple Ordinance dates on the Internet IGI.  This will require your LDS Membership ID 
number along with your date of confirmation and your e-mail address.  The first two items can be 
obtained from you ward clerk.  Click on the “Sign On” link in the upper right-hand corner of the 
opening screen at the FamilySearch.org web site.  Follow the instructions to choose a “user name”,  
a “password” and enter each of the other required fields.  Then the next time you return to the 
FamilySearch web site – click on “Sign On” and enter the selected user name and password. 
 
Step 1: Install the FamilySearcher program 
Visit the web site: http://myweb.cableone.net/kevinowen3/familysearcher.htm and click on the 
“Download” link to begin installing the FamilySearcher application.  The download operation will 
take up to fifteen minutes on a dial-up connection.  Click on “Open” or “Run from current 
location”, depending on your operating system, and follow the on-screen instructions. When the 
installation begins – simply accept the default settings and allow the installation to complete. 
 
Step 2: Use PAF 5.2 to create a GEDCOM file containing the names of those individuals in your 
PAF data with incomplete LDS ordinance information. 
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Step 2a: Create a Focus List 
using the Advanced 
Focus/Filter capability of 
PAF.  Open PAF 5 and load up 
your family data.  Click on the 
Search menu and then on 
Advanced Focus/Filter…  
Select a name from the list for 
the individual you would like 
to start with.  From the 
Relationship Filter, click on 
All Ancestral Related and 
then on Select.  You will then 
be asked if you would like to 
include all of the parents of a 
person – to which you will 
want to answer “Yes”.  Certain 
names in the Search Box will 
now have “>>” in front of them to indicate that they have been selected.  Click in the box marked 
Show results only in order to exclude any names that are not selected by your current Focus Group. 
 

Next we will exclude any 
names from our Focus Group 
that do not need any additional 
LDS ordinances performed.  
This is done by clicking on the 
Define button under the Field 
Filter.  The Field Filtering 
dialog box will be displayed.  
Scroll through the list of 
available filters and highlight 
Qualified for 
Baptism/Endowment and 
then click on the button 

marked “>”.  A window will appear asking whether to use “Is” or “Is Not” qualified.  Choose “Is” 
qualified and click on OK.  This new filter will now appear in the Current Filter list.  Next, click on 
the OR button in the screen area between the Possible Filters and the list of Current Filters 
followed by Qualified for Seal to Parents and “Is” qualified.  Click on OR and then add the 
remaining filter for Qualified for Seal to Spouse and “Is” qualified – and then click on the OK 
button.   
 
The resulting search list will now only contain those individuals that qualify to have at least one 
LDS ordinance performed.  Next, under the Filtered List heading click on the Save… button and 
add a name such as “Incomplete Ordinances” (without the quotes).  This allows returning to this 
Focus/Filter list at any time in the future without having to recreate the above steps – and then click 
on the OK button.   
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Step 2b: Export each name from your PAF data 
that is included in your Focus List to a 
GEDCOM file.  Click on the File menu and 
then on Export…  Under Export To – select 
PAF 5.  Under Include – unselect each of the 
available check boxes.  Under Selected 
Individuals – select Partial and then click on 
the Select button.  You should now see the 
Advanced Focus/Filter dialog box with your 
“Incomplete Ordinances” focus group already 
selected.  Click on the OK button.  Now click 
on the Export… button.  Type in a name for 
this new GEDCOM file that will be created (eg. 
Incomplete Ordinances.ged) and click on the 
Export button.  A summary box will then be 
displayed with a final count of the number of 

individuals and marriages contained in this new GEDCOM file.  Click on the OK button. 
 
Step 3: Use 
FamilySearcher to 
automate the lookup 
of names in the 
GEDCOM file.   
Open FamilySearcher 
by double-clicking on 
the desktop icon and 
login to the Family 
Search web site with 
your username and 
password.  When the 
Security Alert appears 
– click on the Yes 
button to continue.  
Open up the 
GEDCOM file that 
was created in Step 2b 
above by selecting 
“File” and then 
“Open” from the 
menus.  Highlight the GEDCOM file and click on “Open”.  
 
Begin searching the Internet IGI by highlighting the name of a person and then using the 
“Individual”, “Marriage” or “Children of this Couple” searches available from the toolbar.  Use the 
toolbar button showing the silhouette of a person to search for individual ordinances.  Use the 
toolbar button showing the silhouette of a couple to search for marriage ordinances.  Use the toolbar 
button showing the silhouette of a couple with a small child by their side to search for any children 
of the highlighted couple.  Any matching entries will be displayed in the Internet Explorer window. 
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To sort the listed names alphabetically by surname – click on the toolbar button with the AZ on it.  
By clicking on the heading of the columns of the listed names it is also possible to sort by ID, 

surname, 
gender etc.  
FamilySearcher 
will, by default, 
search plus or 
minus one year 
of the event 
date.  This 
default 
behavior can be 
altered by 
clicking on the 
Tools menu 
and selecting 
Search 
Options…  The 
year range can 
then be altered 
to include a 
wider range of 
years according 
to preference.  
Any given 

search can be expanded by using the Refine Search capability provided in the upper right hand 
corner of the 
Internet 
Explorer 
window as 
search results 
are displayed.  
The double-
click action can 
also be modified 
to initiate a 
selected search 
type by using 
the Tools menu 
and then 
selecting 
Configure 
Double-Click 
Action and then 
selecting the 
preferred search 
action. 
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Step 4: Transfer any matching ordinance date information into your PAF data file.  As search 
results are displayed that are determined 
to be matching entries it is possible to 
transfer this detail to your PAF file 
using one of the following techniques.  
Choose the method that best suites your 
situation. 
Step 4a: While viewing a matching 
ordinance entry – click on the 
magnifying glass toolbar icon or the ID 
number and view your record alongside 
the IGI record.  The image at left shows 
a matching entry and the check boxes 
suggest that this ordinance detail is not 
currently included in your file and 
should be added.  Simply click on the 
“Update” button and the ordinance 
dates and temple names will be added.  
Then click on “OK” to dismiss this 
dialog box.  This update can be repeated 

for any number of names.  The updated ordinance information must then be saved to a file by using 
the “File”, “Save Ordinance Update File”.  Make note of this OUP file and then from Personal 
Ancestral File (Roots Magic should also work) – this ordinance information can be added to your 
files using “File”, “Add TempleReady Update…”.   
 
Step 4b: Print out any matching entries and then enter this data into PAF.  This is the simplest 
approach and involves using the File, Print menu in Internet Explorer to print out the matching 
entry for later use in typing into your PAF data files. 
 
Step 4c: Launch PAF 
along with 
FamilySearcher and 
then copy and paste 
any matching entries.  
Use the 
FamilySearcher Tools 
menu to select 
Launch Personal 
Ancestral File 5.  
Use ALT-TAB to 
display the matching 
IGI entry and use the 
mouse to highlight the 
ordinance dates from 
your matching entry 
in the Internet 
Explorer window – 
right click and then 
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select Copy.  Use ALT-TAB to display the PAF 5 window and find the corresponding name entry.  
Right mouse click on the appropriate ordinance field and PASTE the ordinance date.  These steps 
can be repeated any number of times as FamilySearcher finds additional matching entries. 
 
Step 4d: Create a second GEDCOM file containing matching entries and then import this file into 
your PAF data followed by a Match and Merge operation.  For each matching entry found – in the 
Internet Explorer window place a checkmark to the left of the matching name by clicking in the 
box.  This will mark this name for inclusion in a GEDCOM file that will be prepared for download.  
Mark any matching IGI entries in this way and when ready click on the underlined link in the 
Internet Explorer window Prepare selected records for download which can be found near the 
bottom of the page.  This will display a list of names to be downloaded.  Review this list for 
accuracy and then click on the Download GEDCOM link at the bottom of the page.  You will be 
prompted to save this new GEDCOM file to your hard drive – at which point you can change the 
file name or accept the one created for you according to your preference.  Make note of this new 
GEDCOM file name and its location on your hard drive. 

 
Open PAF 5 with your family data loaded and import this new GEDCOM file.  From the File menu 
– select Import… and then browse to the GEDCOM file just downloaded from the FamilySearch 
web site and click OK.  When prompted to proceed with the GEDCOM import – accept the default 
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settings and click on OK.  PAF will next ask if you would like to view instructions on how to merge 
in this new data with your existing data.  Follow the instructions to match and merge each of the 
imported names with those already existing in your file. 
 
 
FamilySearcher was designed to facilitate rapid searching of the Internet IGI but can also be used to 
search the other resources found at the FamilySearch web site.  The pull-down menu provided on 
the FamilySearcher toolbar can be used to search these other resources.  In addition, it is also 
possible to use FamilySearcher to search Ancestry.com, Rootsweb.com and other web sites using 
the “Search” menu or the provided toolbar icons. 
 
FamilySearcher also supports searching of the Family History Library Catalog at FamilySearch.org 
for any matching entries for the locality or surname that is currently highlighted.  Use the toolbar 
icon that looks like a card file to initiate a Library Catalog search.  Take note of the film number 
reported and then take advantage of your local LDS Family History Center where a desired film or 
fiche can be ordered for a nominal fee. 
 
NOTE: Additional help on how to use the FamilySearcher program is provided using the “Help” 
menu from within the program.  Questions about this program or suggestions for possible 
improvements in future versions can be addressed to familysearcher@cableone.net 
 
 


